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Backgrounds can be applied to your
pages to fill the whole page with an image
or pattern that page elements can be
placed on top of. WebEase users can also
apply page borders. 
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HOW TO: APPLY BACKGROUNDS
& BORDERS 
1. Go to the page you want to work on.
2. Click the Images icon in the left column, if 

it isn’t already open.
3. Open the Backgrounds/Borders Library

and select the background or border you 
would like to use.

4. Click “Apply Background” or “Apply 
Border” to place the design on the page. If 
you change your mind about the selected 
image, click “Remove Background” or 
“Remove Border” button to remove the 
design from the page, then select a different 
design.

5. Save the page to complete the process.

The Text icon allows you to add and
change the text elements on the page. 

TEXT

HOW TO: INSERT TEXT
1. Go to the page you want to work on.
2. Click the Text icon in the left column, if it 

isn’t already open.
3. Click the text box you want to work 

with. Double click inside the box to remove 
the filler text.  

4. Type your text or copy and paste it from a 
text document open on your computer. If the 
box already has placeholder text in it, the 
text will automatically be removed when you 
begin typing.

5. How to make text fit in a text box:  If your 
text does not fit in a text box, the site will ask
you to fix this issue by choosing one of the 
following options: 
•Manually correct the text (e.g., reduce font 

size, delete part of the copy, change the 
style) to fit in the text box.

•Automatically lengthen the text box (if 
space is available) to accommodate the 
text.  

•Automatically create additional text box(es)
to the right of the original text box (if space
is available) and flow the extra text into the 
box(es). 
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The Font Control Palette is where you can
change the font attributes of the entire
text box, or just a highlighted section
within the text box.

FONT

FYI: FONT ATTRIBUTES
When you first enter text, it will default to the
style you assigned in Styles & Settings. You can
either keep it as the default style, or you can
manually change one or more of these attributes: 
• Style: Changing the Style attribute will 

change the entire text box to match the font, 
size, color and all other attributes of the 
selected style.

• Font: Changing the Font attribute will 
change the font of the text, but will retain the
original size, color, and other attributes of the
original text.

• Font Style: You can change the font style to 
make the selected text bold, italic, 
underlined, or add a drop cap. Clicking these
icons will toggle the attribute on and off.

• Size: Changing the Size attribute will make 
the text bigger or smaller.

HOW TO: TEXT FORMATTING
• How to apply color to text: Highlight the text

on the page, and then select a new color 
from the color palette in the Color & Effects 
Control Palette.

• How to make a text box transparent: Select
the text block, then click the Properties tab. 
In the Fill control palette, select “None” to 
make the text box transparent.

• How to add color to a text box: Select the 
text block, then click the Properties icon. In 
the Fill section, select a new color and/or tint
from the color palette.

• How to find and replace words: You can 
select “Find and Replace” in the Page 
Actions Menu to find a specific word or 
phrase on the current page or double page 
spread. If desired, you can automatically 
replace each instance of the word or phrase 
with a new word or phrase. 

• How to review color choices: Do not rely on
the colors shown on your computer monitor. 
Instead, refer to the Color Sampler in your kit
to see actual printed samples of the 
predefined colors. 
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The Spacing & Alignment control palette
is where you can adjust several text
attributes to achieve the typographic
effect you want.
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FYI: SPACING & ALIGNMENT
ATTRIBUTES

• Alignment: The Alignment attribute 
determines the left-to-right placement of the
text within the box. Text can be aligned to the
left, centered, aligned to the right, or 
justified. “Left alignment” or “Right 
alignment” means one side will be aligned 
and the other side will be ragged. “Centered”
means all lines will align down the middle of 
the text box. “Justified” means the lines will 
be aligned on both the right and the left by 
spreading or compressing the text on each 
line.

• Leading: The Leading attribute determines 
the amount of space between each line of 
text. The larger the number, the more space 
there will be between lines.

• Kerning: The Kerning attribute determines 
the amount of space between specific 
letters. If kerning is “on,” the system will 
automatically adjust the kerning settings 
between pre-programmed letter pairs, so the
spacing looks even to the reader. If kerning is
set to “none,” all letters will have the exact 
same amount of space between them.

• Tracking: The Tracking attribute adjusts the 
amount of space between letters or words. If
tracking is set to “none,” the words will be 
spaced according to the normal font settings.
Increasing the number will increase the 
space between letters or words.

• Margin: The Margin attribute adjusts the 
amount of space between the text and the 
outside of the text box.

The Color & Effects control palette lets
you change several visual attributes of the
text.

COLOR & EFFECTS

FYI: COLOR & EFFECTS
ATTRIBUTES

• Color: You can adjust the color of the text by
selecting a new color in the color palette.

• Tint: If you don’t want the text to be in solid 
color, you can type in a specific percentage 
or use the slider bar to adjust the tint of the 
color. The higher the number, the darker the 
text.
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The Add Elements icon is where you can
create new elements and bring visual
interest to your page. The element options
are grouped into three categories: 
• Image Elements are boxes and other 

shapes that can contain images.
• Text Elements are boxes that can 

contain text.
• Shapes & Lines are elements that can 

add visual interest to the page (but 
can’t contain images or text).
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The Special Characters control palette
makes it easy to add unique text
characters. Just place your cursor in the
spot you would like the special character
to be located, and then click the desired
character from the list in the control
palette.

SPECIAL CHARACTERS

HOW TO: ADD ELEMENTS
1. Go to the page you want to work on.
2. Click the Add Elements icon in the left 

column, if it isn’t already open.
3. Identify the element you want by viewing 

the options in the Image Elements, Text 
Elements, and Shapes & Lines groupings.

4. Add the selected element to the page
through one of two methods:
• Click the element, then click the page

and drag the cursor to define the size of 
the element. 

• Drag and drop your selected element 
onto the page. Then, adjust the size by 
dragging the corners of the element box.

5. Repeat these steps until you have finished 
adding elements.

6. Save the page to complete the process.
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The Shape control palette allows you to
change the shape of your selected object
by clicking a different shape within the
palette.

SHAPE

The Properties icon is where you can
apply image effects, change shapes, fill
shapes, apply line borders to elements,
and adjust the size and position of placed
elements. The Image Effects control
palette is only available when you have an
image selected on your page.

PROPERTIES

IMAGE EFFECTS The Image Effects control palette enables
you to enhance and manipulate your
photos and other images. 

FYI: IMAGE EFFECTS
• Color: Lets you change the image from full 

color to sepia tone or black & white. 
• Ghosting: Adjusts the brightness of the 

image in 10% increments.
• Fade: Allows you to apply a light, medium or 

heavy fade to the edges of the photo. 
• Resize: Adjusts the size of the image within 

the image element between 1% and 200% 
by moving the slider bar or typing a 
percentage directly into the Resize box.

• Reposition: Lets you drag the image to the 
desired position within the image box.

• Rotate: Changes the rotation of the image 
within the element box by typing a specific 
rotation in the box, or rotating in 90-degree 
increments (clockwise or counter-clockwise).

• Flip: Mirrors the image vertically (top to 
bottom) or horizontally (left to right).



BOOK CREATION: BUILD

Book Creation: Build   63Lifetouch Online Yearbooks Guide

FILL

The Fill control palette lets you fill any
element with color. You can also adjust
the tint if you don’t want the color to be
solid.

BORDER
The Border control palette allows you to
add a border to an element, and give it
specific attributes. 

FYI: BORDER ATTRIBUTES
• Size: The point size for your border can be 1,

3, 5, 9 or 13
• Color: The border can be any color within the

color palette.
• Style: The style of the border can be solid, 

dashed or dotted.
• Tint: The tint of the color can be adjusted if 

you don’t want the border to be 100% of the 
color.

DROP SHADOW
The Drop Shadow control palette is where
you can add a drop shadow to a selected
element. Just click “Shadow” in the Drop
Shadow Control Palette, and adjust the
drop shadow attributes. Shadows are only
allowed on text when the text box is not
filled. As Soon as you add a fill to a text
box, the shadow moves from the text itself
to the text box.

FYI: DROP SHADOW
ATTRIBUTES

• Color: The drop shadow can be any color 
within the color palette.

• Tint: If you do not want the drop shadow to 
be 100% of the color, you can type in a tint 
value, less than 100% or use the slider bar.

• Position: Indicate the position of the drop 
shadow by dragging the black square to the 
desired location. As you are moving it, you 
will see a preview of where the drop shadow 
will be placed.

SIZE & POSITION

The Size & Position control palette is
where you can adjust the size, position,
rotation and other attributes of the
selected element.
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Standard keyboard shortcuts that can be
used in the Book Creation>Build section.

KEYBOARD SHORTCUTS

Action Key
Redo Ctrl+Y
Undo Ctrl+Z

Save Page Ctrl+S
Add Item Mode Ctrl+A
Cut to Clipboard Ctrl+X

Copy to Clipboard Ctrl+C
Paste Ctrl+V

Templates Control Palette Ctrl+1
Images Control Palette Ctrl+2

Text Control Palette Ctrl+3
Add Element Control Palette Ctrl+4
Properties Control Palette Ctrl+5

Zoom In Ctrl++
Zoom Out Ctrl+-

Move Selection Arrow keys
Move Content Arrow keys

(in content manipulation mode)
Delete Selection Del
Group Selection Ctrl+Shift+G

Ungroup Selection Ctrl+Shift+U
Rotate Mode Ctrl+Shift+R

Send Selection to Front Ctrl+Shift+F
Send Selection to Back Ctrl+Shift+B
Open Save As Dialog Ctrl+Shift+S
Rotate 270 Degrees Ctrl+Shift+E
Rotate 90 Degrees Ctrl+Shift+T

Flip Shape Horizontal Ctrl+Shift+H
Flip Shape Vertical Ctrl+Shift+V

Fit to Screen Ctrl+Shift+W
Multi Select Mode Shift

(while shift key pressed)
Bold Ctrl+Shift+B

(in content manipulation mode)
Italic Ctrl+Shift+I

(in content manipulation mode)
Underline Ctrl+Shift+U

(in content manipulation mode)
Align Center Ctrl+Shift+E

(in content manipulation mode)
Align Left Ctrl+Shift+L

(in content manipulation mode)
Align Right Ctrl+Shift+R

(in content manipulation mode)
Justify Ctrl+Shift+J

(in content manipulation mode)
Shape Distortion Mode Alt+Double Click

* Mac users should use the 
Cmd key in place of Ctrl
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To view pages properly, you may need to
adjust the default settings in your Web
browser. First, you should make sure you
are using a supported browser.
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HOW TO: CONFIRM YOUR
BROWSER MEETS SITE
REQUIREMENTS 
• If you are using Internet Explorer, open a 

browser window and select “About Internet 
Explorer” in the Help menu. If it tells you that
you are using a version older than 6.0, you 
will need to download the latest version from
the Microsoft® website. 

• If you are using Firefox, open a browser 
window and select “About Mozilla Firefox” in 
the Firefox menu. If it tells you that you are 
using a version older than 2.0.0.14, you will 
need to download the latest version.

HOW TO: ADJUST YOUR 
SETTINGS - CACHE
To view pages properly, you may need to adjust
the default settings in your browser.

INTERNET EXPLORER v6.0 - WINDOWS
• With your browser window open, go to 

Help> About Internet Explorer and confirm 
the version number is v6.0 or higher. 

• If you have an older browser version, you 
can download the latest version from the 
Microsoft® website. 

• Go to Tools> Internet Options. From the 
Temporary Internet Files area, click Settings. 

• From the Check for newer versions of stored 
pages area, select Every visit to the page. 

• Click OK on the Settings window and OK 
again to close the Internet Options window.

INTERNET EXPLORER v7.0 – WINDOWS
• With your browser window open, go to 

Help> About Internet Explorer and confirm 
the version number is 7.0.

• Go to Tools> Internet Options. From the 
Browser History area, click Settings.

• Click OK on the Internet Options dialog box.  
In the “Temporary Internet Files and History 
Settings” dialog box, look at the top for the 
setting to Check for newer versions of stored 
pages:  and then select Every time I visit the 
webpage. 

• Click OK on the “Temporary Internet Files 
and History Settings” and OK again to close 
the Internet Option.

Lifetouch Online Yearbooks Guide
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HOW TO: ADJUST YOUR 
SETTINGS - CACHE
FIREFOX – WINDOWS AND MAC
• Type about: config in the address box and 

click Enter.
• Look for the preference name 

browser.cache.check_doc_frequency.
• Double click the preference name 

browser.cache.check_doc_frequency to 
open the Enter integer value dialog box.

• Enter the value 1 and click OK to close the 
dialog box.

ADJUSTING COMPUTER SETTINGS –
COOKIES
Each time you sign into your account, a
temporary cookie (small text file) is stored
on your computer. When you sign out or
close the program, the cookie is removed.
If you keep returning to the Sign In screen,
even after you’ve entered the correct user
information, you might need to reset your
browser to allow cookies.

HOW TO: ALLOW COOKIES PC
Internet Explorer v6.0 & v7.0
1. Go to Tools and select Internet Options
2. Go to the Privacy Tab and set the Internet 

Zone to “Medium” or “Low”.
3. Click “Advanced” and select both “Override 

automatic cookie handling” and “Always 
allow session cookies”. 

4. Click “OK” to close the Advanced Privacy 
Settings window.

5. Click “OK” again to close the Internet 
Options window.

Firefox on a PC
1. Go to Tools and select Options.
2. Go to Privacy.
3. Find Cookies and select “Accept cookies 

from sites”.
4. Click “OK” to save changes.
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HOW TO: ALLOW COOKIES MAC
Firefox on a Mac
1. Go to the Firefox menu and select 

Preferences
2. Select the Privacy tab
3. Go to Cookies and select “Accept cookies 

from sites”
4. Click “OK” to save changes.

Safari on the Mac
1. Select Preferences from the Safari menu. 
2. Click the Security icon near the top of the 

window. 
3. Go to Accept Cookies and make sure either 

the “Always” or “Only from sites you 
navigate to” option is selected. 

4. Close the Security window and the Safari 
Preferences window.
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COMPUTER MEMORY (RAM)
The site recommends at least 512MB of
RAM or higher (memory) to operate. If
you are having trouble saving, or if your
computer locks up, you may need to
increase the memory allocation.
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HOW TO: CHECK YOUR RAM
PC
1. Click Start and select Settings
2. Go to Control Panel in the Task Bar. 
3. Double-click “System”. 
4. Go to General tab to view the RAM and 

operating system. 
5. Click Cancel to close the System Properties 

window, then close the Control Panel 
window.

MAC
1. Open the Apple menu (click the little apple in

the upper left corner of the screen). Choose 
either About This Mac or About this 
Computer.

2. Look for the Total Memory Line.
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MONITOR RESOLUTION
The site is designed to work best at a
resolution of 1280 x 1024, but it will also
work at a resolution of 1024 x 768.
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HOW TO: SET MONITOR
RESOLUTION
PC
1. Go to Start and select Settings.
2. Go to Control Panel and double-click the blue

Display icon. 
3. Go to the Display Properties window, and 

then the Settings tab. 
4. From Screen Area, move the slide bar to the 

right toward the “More” label, until it is set 
at either 1024 x 768 or1280 x 1024. 

5. Click Advanced and select the General tab. 
6. From the Font Size area, select Small Fonts 

from the drop-down list. 
7. Click “OK” to exit each window. 

NOTE:  You may have to click “OK” a few times
while Windows resets your monitor settings.

MAC
1. Open the Apple menu (click the “apple” logo 

in the upper left corner of the screen).
2. Select Systems Preferences
3. Select the Displays icon.
4. Select either the 1024 x 768 setting or the 

1280 x 1024 setting and your monitor will 
automatically adjust to the new setting.
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FYI: TIPS TO PREVENT
PROBLEMS

• Anti-Spyware: For the best experience with 
our website, we recommend that you install 
Anti-Spyware software on your computer. 
Anti-Spyware is security technology that 
helps protect Windows users from spyware 
and other potentially unwanted software. You
can get anti-spyware software at 
www.microsoft.com

• Pop-ups: Lifetouch uses Pop-ups 
throughout the website. If you use Pop-up 
blocker software, you must configure it to 
accept the following domain: 
http://onlineyearbooks.lifetouch.com 

• Firewalls: If you use a firewall, you must 
configure it to accept the following domain: 
http://onlineyearbooks.lifetouch.com. 
Contact your Network Administrator to verify 
the firewall is not drastically slowing down 
Internet connections. If your connections are 
too slow, you could time out during certain 
requests, like uploading photos. Also, verify 
that the configuration will let you access and
receive information from Lifetouch Web sites.

• Spam Filters: To ensure you receive 
important e-mails from Lifetouch, add 
lifetouch.com to your approved e-mail list.

• Printing Pages: Change margins if you have
trouble fitting images on a page when 
printing. Go to File > Page Set-Up and 
adjust the margins accordingly (e.g., 0.5” on 
each side).

FYI: GOOD PRACTICES
To eliminate some common issues when
accessing the site, you should:
• Close all unnecessary applications, 

especially applications that require a lot of 
resources such as an Internet radio. 

• Save your work often, approximately every 
15 minutes. 

• Don’t wait until the last deadline to upload
all images, create pages and view proofs. 
The weeks before the last deadline is a busy 
time for Lifetouch servers, causing the server
response time to be slower than during off-
peak times.

NOTES:
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HOW TO: TROUBLESHOOT A
TECHNICAL PROBLEM
• Determine where the problem stems from

(computer hardware, configuration or from 
the school’s network). 

• If a process worked before, but doesn’t now,
check whether anything has changed on 
the computer or school’s network. Has a 
new application been installed, or changes 
made to the computers network or firewall? 
You might need to contact your System 
Administrator for information. 

• Try a different computer and see if the 
problem is replicated. If not, the problem is 
most likely isolated to the one computer. 
Contact your Network Administrator for help.

• Check the bandwidth on your network by 
using an Internet search engine to search for
“connection speed” (These sites are trying to
get you to buy a tool, but often they will give 
you one free test of your Internet 
connection). DSL connections typically have 
a bandwidth of 768 kbps and cable 
connections are typically 1.5 mbps.

• Upload images, create pages, and view 
proofs intermittently, rather than all at 
once right before the deadline. If possible, 
work on the yearbook when there is low 
activity on the school’s network.

• Contact your ISP if you are getting dropped 
from the Web site, your connection speed is 
slow, or you have determined (to the best of 
your ability) it is not an issue related to your 
computers or network. It will be most helpful 
if you can provide them with the following 
information: 
• What time the error/issue occurred.
• The exact error message, if you received 

one. Take a screen shot of the error 
message so you have it for reference or 
can e-mail it if requested.

• Contact your Lifetouch Customer Care 
representative if your ISP is unable to 
troubleshoot your issue. Provide the following
information:
• What time the error/issue occurred.
• Which screen you were working on 

and/or the exact error message (to print 
the error message: click the “Print 
Screen” button on the upper right hand 
side of your keyboard, so you have it for 
reference or can e-mail it if requested.)

• Indicate whether multiple users 
experience the issue.

NOTES:
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A Year in the Life (Volumes)/A Year in Review (WebEase):
A 16-page, full color year-in-review insert that can be
stitched or taped in the yearbook. It features the year’s
biggest news stories, sports achievements and hottest
entertainment buzz. 

Account Executive:  Your Lifetouch contact for questions
or assistance.

Activity Photo: Any photo that is not a portrait. Activity
photos include un-posed (candid) subjects or posed
subjects such as club, team or class photos.

Adobe®Reader®: The software program that the site
uses to view PDF proofs of yearbook pages.

Adviser:  Person (usually a teacher or school
representative) who directs the yearbook process at the
school from start to finish. 

Alignment: Bringing letters of a line of type together into
exact position—either left justified, centered, right
justified, justified or full justified.

Approve:  To accept the page you have submitted to
Lifetouch, or to accept the changes that Lifetouch made to
your page, according to your special instructions.

Artwork: Photographs, drawings, hand lettering and line
art, which is prepared for illustration on a yearbook page.

Aqueous Coating: A glossy, environmentally-safe coating
on soft cover yearbooks.

Background: Design, pattern or image used to fill and
enhance the yearbook page design.

Baseline: The line on which all letters rest.

Base Color: The first color used as a background on
which other colors are applied.

Candid Photo: An activity photo in which the subjects are
informal, spontaneous, and not posing.

Caption: Text located near a photo that explains what is
happening in the photo.

Clip Art: Graphical artwork used to enhance the yearbook.

CMYK (Cyan, Magenta, Yellow, and Black): The four
colors used in the printing process.

Close Register (or Tight Register): Required when photos
and artwork, screens or rule-lines are butting each other.

Copy: Text in a book. It can be body copy, caption copy or
headline copy.

Credit Line (or Byline): A statement giving the name of
the person responsible for a picture or copy. 

Crop: To eliminate (opaque, mask, cut or trim) portions of
an illustration or photo to fit a specific area, or to capture
only a portion of the photo on a yearbook page.

Custom Template: Original page templates created by a
school.

DPI (Dots Per Inch): Used to measure resolution for
scanning and printing. Generally, more dots per inch
means a higher resolution, a greater amount of visible
detail in the image, and a larger file size.

Deadline: Date by which pages, cover designs or other
production-related materials are due at the publishing
plant.

Digital Image: A photo composed of pixels (captured on a
digital camera, scanned or created from scratch with
image-creation software). 

Double-Page Spread: A spread with cross-gutter
elements.

Download: To take photos from a digital camera and
transfer them to a computer. Can also mean transferring
files from an e-mail or from a website to your own
computer.

Em Space: A printer’s unit of space measurement equal
in width to the letter “m” in the selected type size. 

Endsheets: Sheet of heavy text stock paper that is used to
attach the inside pages of a hard cover yearbook to the
cover. One half of the endsheet is adhered to the inside
cover, while the other half creates a page in the book. 

Enlargement: A reproduction larger in size than the
original.

EPS (Encapsulated PostScript): An Adobe graphic file
format. If graphics do not export or import well as a TIFF
(Tagged Image File Format), EPS is another option. EPS
translates graphics and text into a code that the printer
can read and print.

Error Message: A message you receive when there are
technical difficulties with the Internet connection or an
action you are trying to make.
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Export: A process to create a file in a format that is
compatible with other applications. This option can usually
be found under the File menu in most graphics software
applications.

Finish: The surface property of a sheet of paper, such as
gloss or matte.

Firefox: A web browser available on PCs and Macs (this
site supports v2.0.0.14 -v3.1).

Flowing: Arranging the portraits on the page. Once your
have finished proofing your portraits and you have selected
enough pages for each of your sort values, you will be
asked to flow your portraits onto your portrait pages. 

Flush: Usually refers to typeset copy that is even with the
margin or photo box.

Flush Left: Refers to typeset copy that is straight on the
left edge of the printing or text area.

Flush Right: Refers to typeset copy that is straight on the
right edge of the printing or text area.

Foil Imprinting: Tissue-thin material faced with metal or
pigment used in book stamping with stamping dye. Foil
Imprinting has a high gloss, metallic shine. Foil Imprinting
is available in a variety of colors.

Fold-Out: A page that exceeds the dimensions of a single
page. It is folded to page size and included in the book,
sometimes bound in and sometimes tipped (pasted) in.
Available in Volumes only.

Folio:  Small graphic elements designed to be places near
the page number.

Font: An assortment of type of one size and face
containing all of the characters needed for ordinary
composition. The term refers generically to letter styles.

Four-Color Process: A reproduction of color made by
means of photographic separations.  Four-color printing
uses cyan (blue), magenta (red), yellow and black inks,
each requiring its own plate. This is the means of four-
color reproduction in printing.

Full-Color: Another term for four-color process. A
reproduction of color made by means of photographic
separations. Four-color printing uses cyan (blue), magenta
(red), yellow and black inks, each requiring its own plate. 

Ghosting: Adjusting the brightness of an image.

Gloss: Surface quality of paper that reflects light.

Gutter: Short for Gutter Margin – the margin in the middle
of a double-page spread.

HTML (Hypertext Markup Language): A programming
language for websites that can incorporate text, graphics,
sound, video and hyperlinks.

Hairline: A line used on templates to indicate the position
of a photo or copy. The line is typically not printed in the
final yearbook.

Headline: Words set at the head of a page to introduce or
categorize.

Headsize: The size of the portrait box that the portrait
images will be placed in. 

Hot Foil: Tissue-thin material faced with metal or pigment
used in book stamping with stamping die. Hot Foil has a
high gloss, metallic shine. Hot Foil Namestamping is
available in a variety of colors. 

Internet Explorer (I.E.): A web browser available on PCs
and Macs (this site supports v6.0 and v7.0 on the PC
only).  

Image: Any picture, clip art or scanned text that can be
placed in a photo box.

Italic: Style of letters that slope forward, often used for
words requiring emphasis. 

JPEG (Joint Photographic Experts Group): A bitmap file
format that uses compression to make images take less file
space.

Justify: To set type or prepare text composition to a
specified width or measure so that the left and/or right-
hand margins of the printed matter will be aligned.
Justification may be accomplished by adjusting the
spacing between words and characters to fill the measure
with each full line of type.

Kerning: Adjusts the preset space between pairs of letters.
Kerning takes away some of the space between letters to
create a more visually pleasant configuration. Kerning is
strictly proportional so that the space gets bigger or
smaller at the same rate as the characters. 

LPI (Lines Per Inch): A unit of measurement used to
describe resolution by specifying the number of lines that
are printed in an inch. The higher the number of lines, the
higher the print quality. 
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Ladder Diagram: A planning tool used to plan the contents
of each page of the yearbook—an important first step in
designing the yearbook. 

Leading: The space between lines. You can change leading
if you want to increase or decrease the space between
lines of text.

Login Information: The unique and secure information that
each user must provide in order to gain access to the site,
including the job number, a user name and a password. 

Low Resolution (Lo-Res): Low-resolution files require less
memory than high resolution files, and are only acceptable
for monitor display. Resolution is calculated in “dots per
inch”(dpi). A standard low-resolution scan is 72 dpi or 96
dpi. On this site, images appear in lo-resolution on screen,
but will be replaced with the high-resolution image when
printed in the final yearbook. 

Matte Finish: Dull paper finish without gloss or luster.

Modified Type: Any caption or name that will not show up
well if it is reversed or overprinted on a photograph, or if
artwork has to be modified to make it readable. 

Montage Page: Created by pasting overlapping photos
onto a Layout Board—a fun way to feature a lot of student
photos on a yearbook page. 

Moiré: Undesirable patterns occurring when reproductions
are made from pre-printed material.

Natural Spread: Two facing pages in a book that are
printed together within a flat. Because they are printed at
the same time, photos that extend across the gutter of the
yearbook should be placed within a natural spread. In
Smythe sewn books, each 16-page signature of the book
will include a natural spread (e.g., pages 8 and 9 are a
natural spread).

PDF (Portable Document Format): An Adobe® electronic
document format that allows the distribution and display
of a document as originally designed and formatted,
without having the software application or fonts loaded on
the viewing computer.

PPI (Pixels Per Inch): A unit of measurement describing
the amount of data contained within a bitmapped image.

Pica: A printer’s unit of measurement for length of lines
and depth of type pages. Six picas equals one inch.

Pixel: The smallest units of data in a digital image (the
little squares you see when you zoom in on a photo).
Together, pixels constitute a digital image. A pixel’s code
contains information related to color and placement within
the larger image.

Point: A printer’s unit of measurement used principally for
designing type size. There are 12 points to a pica and 72
points to an inch.

Portrait: An individual photo of a student or staff member
issued in the creation of the portrait pages of the yearbook.

Proofs: Files that represent how a page will look in the
final book. On this site, page proofs are generated
electronically and are viewable with Adobe® Reader®.

RGB (Red, Green, Blue): The color scheme used to
display color images on computer monitors.

Refresh: An action that re-loads your current web page
within the browser window. You should frequently click the
“Refresh” button located at the top of your screen to
update your page. This is helpful in a situation where
someone else might be working on the same section of the
book.

Resolution: The number of pixels (picture elements) per
unit of linear measurement (inch) on a computer monitor,
or the number of dots per inch in a digital picture. 

Reverse: Type appearing in white (color of the paper) on a
black or color background, or in a dark area of a
photograph. 

Save: Keeps any changes that you have made to a page.

Scanner: An input device that digitizes images, creating
digital images that may be manipulated electronically.

Smythe Sewing: A book-binding process in which 16-page
signatures are folded and trimmed to create a 16-page
section. These 16-page sections are stitched together and
inserted into the cover. 

Sort Value: When pictures are uploaded to the site, they
are placed in sort values. Portraits are separated into
different sort values according to grade, homeroom or
teacher ID.

Square-Back Binding: A hardcover binding process that
uses state-of-the-art production technology to create a flat,
durable spine.
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Submit: To send your saved work and any special
instructions to Lifetouch. 

Supplement: An additional insert to capture year-end
activities that occur after the early submission deadline.
Supplements may be stitched in or include an adhesive
strip so that the students can insert it into books after
delivery. 

Thumbnail: A small preview of a yearbook page, which
can be found in the Ladder Diagram and throughout the
site. Clicking on the thumbnail will open up the page in
the corresponding “builder.” 

TIFF (Tagged Image File Format): TIFF files can be color
or grayscale. Their resolution or dpi determines the quality
of the image. When exporting images for use in
QuarkXPress® or InDesign®, choose this format first. If it
does not work well, the EPS format should be fine. If using
graphics like line art, an EPS file format is recommended
instead of TIFF.

Tint: A screened-back version of a pure color, measured in
a percentage amount. Full color is 100%, and a tint is a
version of that color that is less than 100%.

Tracking: Determines the amount of space between letters
and words. Tracking adjusts the relative space between
characters so that it gets slightly tighter at large sizes and
slightly looser at small sizes. You can choose to increase or
decrease the tracking in increments of five points.

Trim Size: The final size of yearbook page. 

Upload: Transferring information from a personal computer
to Lifetouch.
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Add Name to Portrait Library....................................47
Add Names to Index................................................49
Add Sort ................................................................46
Apply Borders and Backgrounds .........................19, 58
Apply Templates .........................................29, 54, 55
Approve Pages........................................................30
Assign Color Pages ..................................................17
Assign Deadlines.....................................................17
Assign Spot Color....................................................18

Body Copy .............................................................23
Book Settings ....................................................17-24
Borders & Backgrounds - Defaults.............................19
Borders & Backgrounds in Build ...............................58
Borders for Page Elements .......................................63
Browser Requirements.............................................65
Browser Setup ..........................................................7
Build Pages.......................................................51-64

Cache: Adjust your Settings................................65, 66
Change a Page Template..........................................54
Change Portrait Images............................................42
Color & Deadline Assignment ...................................17
Color & Effects for Text ...........................................60
Contact Information...................................................5
Cookies: Allow on a Mac..........................................67
Cookies: Allow on a PC............................................66
Copy Templates ......................................................33
Cover & Endsheets - Volumes ...................................28
Cover & Endsheets - WebEase .............................26-27
Cover Artwork.........................................................28
Cover Book ............................................................27
Cover Proofs ...........................................................27
Create a Custom Style .............................................22
Custom Templates...................................................48
Custom Dictionary ..................................................24
Customize your Sales Tracker List .............................15
Customize your Site...................................................8

Drop Cap for Text ....................................................59
Drop Shadow for Page Elements ...............................63

Element Actions Menu.............................................53
Export Portraits from Portrait Library .........................46

FAQ’s ....................................................................11
Fill Page Elements...................................................63
Font ......................................................................59
Fonts - Select your Defaults......................................20

Glossary ................................................................72
Good Practices .......................................................70

Home .................................................................9-16

Icons .....................................................................51
Image Details ...................................................39, 57
Image Effects .........................................................62
Image Libraries..................................................38-40
Image Library - Create new folder .............................40
Image Library - Delete folder ....................................40
Image Library - Rename folder .................................40
Image Management.................................................35
Image Usage ..........................................................41
Images ............................................................56, 57
Import from previous year ..........................................7
Import to Custom Dictionary ....................................24
Index Editor.......................................................49-50
Index – Enter Names in Image Library .......................39
Insert Text ..............................................................58

Kerning............................................................21, 60
Keyboard Shortcuts .................................................64

Ladder.............................................................29, 30
Libraries ...........................................................35-40
Link Text Boxes.......................................................59
Login.......................................................................6

Mail CD’s and Prints to Lifetouch ..............................37
Manage Users ........................................................12
Master Pages..........................................................31
Monitor Resolution..................................................69
My Profile ..............................................................10
My Tasks ...............................................................10

A

B

C

D

E

F

G

H

K

L

M

I



INDEX

Index  77Lifetouch Online Yearbooks Guide

Upload Images ..................................................36-37

Video Tutorials ........................................................11
View Book..............................................................25
View Menus ...........................................................53
View Proofs ............................................................32

Yearbook Checklist ....................................................9
Yearbook Deadlines ...................................................9
Yearbook Page Status Report ....................................11
Yearbook Preview....................................................32

Organize Pages .......................................................33
Overall Site Navigation ..............................................8

Page Actions Menu ............................................52-53
Page Control Palettes...............................................51
Page Details ...........................................................56
Place Images on Page..............................................56
Placed Images ........................................................57
Plan .................................................................25-34
Portrait Default Settings ...........................................19
Portrait Details........................................................42
Portrait Flow Guidelines......................................44-45
Portrait Library .................................................42, 43
Proof Covers ...........................................................27
Properties ..............................................................62

RAM......................................................................68
Resize and Move Images..........................................57
Re-sort Portraits......................................................47
Resources .........................................................65-74

Sales Tracking & Resources.................................14-15
Search Image Library ..............................................41
Search Portraits ......................................................46
Security Statement ....................................................6
Select a Page Template.................................29, 54-55
Shapes ..................................................................62
Shortcuts ...............................................................12
Site Preferences ......................................................24
Size & Position of Page Elements ..............................63
Sort..................................................................42-47
Spacing & Alignment of Text.....................................60
Special Characters ..................................................61
Spot Color ..............................................................18
Student Frequency Report ........................................11
Styles ...............................................................21-23
Submit Pages .........................................................30
System Check...........................................................6
System Requirements................................................5

Template Library.....................................................48
Text Formatting..................................................58-59
Traffic Report..........................................................11
Troubleshooting .................................................65-71
Typography Recommendations .................................22

P

R

S

T

V

Y

O U




